Introduction

Welcome! This guide is intended to support you, the administrator, in deploying Corel® WordPerfect® Office X6 to your network.

Are you new to network deployment? For a nontechnical introduction to the concepts and processes discussed in this guide, please see the companion Corel® Beginner’s Guide to Network Deployment.

Contents

Stage 1: Preparing for deployment .......................... 2
Stage 2: Creating the server image ......................... 6
Stage 3: Installing the software ............................ 10
Stage 4: Maintaining the installations ..................... 20
Appendix: Specialized deployment scenarios .............. 26

Conventions

Please note the following conventions used in this guide.

Wherever you see this You’ll find
italicized text A placeholder for user-specified information, such as a path or filename
bold monospace text A reference to programming syntax

For more information

The following resources offer additional support.

For information on See the following resource
deploying Corel® software: concepts & processes, general advice & best practices Corel Beginner’s Guide to Network Deployment
Corel Corporation, or a specific Corel® website: Corel software product
Corel website: www.corel.com
support for Corel software Corel® Support Services website: www.corel.com/support
the Microsoft® Windows® Installer (MSI) technology, which is Microsoft® website
used to install Corel software
Stage 1: Preparing for deployment

Before beginning the deployment, take the time to familiarize yourself with your network and the software you want to deploy to it. Doing so can help your administrative duties run as smoothly as possible.

In this stage

Getting to know your network ............................................. 2
Getting to know the software ............................................. 2
Setting up your network accordingly ................................. 3

Getting to know your network

Make sure to consider your network requirements for the deployment.

Administrative factors Does your organization (or do you, as administrator) have any particular requirements for deploying and maintaining software?

Server factors Does your server have any special characteristics or constraints?

Workstation factors Do your workstations have any special characteristics or constraints?

User factors Do your workstation users have any special workflows?

For more information

For general guidance on assessing your deployment needs, please refer to “Processes: Stage 1” in the Corel Beginner’s Guide to Network Deployment.

Getting to know the software

Make sure that your server and workstations are eligible for the software. If your organization uses a document-management system (DMS), make sure that it is supported by the software.

Server requirements

You can create an image of WordPerfect Office X6 on a server that meets the following requirements:

- Operating system with the latest service pack and critical updates:
  Windows Server® 2008 or Windows Server® 2008 R1, or Windows Server 2003
- 1 GB of server space (for a typical installation without extra content)

Windows® Terminal Server (2008 or 2008 R1, or 2003) is supported, but please note the following:
• You must use the WordPerfect Office X6 DVD to install the software on the server.
• Corel Corporation does not provide technical support for installing third-party software included with the product.

For details on server permissions, see “Server setup” on page 3.

**Workstation requirements**

You can install WordPerfect Office X6 on workstations that meet the following requirements:

- Operating system with the latest service pack and critical updates:
  - 32-bit or 64-bit version of Windows® 7, Windows Vista® or Windows XP
- Pentium® III (466 MHz)
- 256 MB of RAM
- 660 MB of hard-disk space for minimum installation (Paradox, if included, requires an additional 215 MB of hard-disk space.)
- Mouse or tablet
- 800 × 600 (or greater) screen resolution; 1024 × 768 or greater recommended
- Microsoft® Internet Explorer® 6.0 or later

Some features also require Microsoft® Outlook®.

For details on workstation permissions, see “Workstation setup” on page 4.

**DMS requirements**

WordPerfect Office X6 offers support for the WordPerfect® (WPD) format on the following document-management systems:

- Microsoft® Office SharePoint® Server 2007 with SP1
- SharePoint Portal Server 2003

For details on SharePoint setup, see page 4.

**For more information**

For important notes on installing and using the software, it’s a good idea to review the Readme file for the software.

**To access the Readme file on the installation disc**

- Run the following command line (where X: is the disc drive):
  
  X:\Readme.html

---

**Setting up your network accordingly**

After familiarizing yourself with your network and the software you want to deploy to it, you can set up your network accordingly.

**Server setup**

Do the following:
• Make sure that you are either a local administrator or an administrator for the domains and workgroups that you are managing.

• Create a shared network location for the server image, and make sure that you have read/write access to that location.

If you want to make extra content (such as clipart and videos) available to workstation users, do the following:

• Set up a shared network location, and make sure that users have access to that location.

• Use the program DVD to install or copy the content to the shared location.

Workstation setup

Do the following:

• Make sure that you are — and anyone else who will be installing the software is — either a local administrator or an administrator for the domains and workgroups that you are managing.

• Make sure that you have — and anyone else who will be installing the software has — read access to the server-image location.

GPOs

To more easily manage the access rights of workstation users — especially for pull-installation scenarios — you may want to consider using Group Policy Objects (GPOs). The Corel Beginner's Guide to Network Deployment offers basic information on GPOs. For more advanced information, please refer to the Software Development Kit (SDK) for Group Policy.

SharePoint setup

As part of your SharePoint solution, Microsoft provides a tutorial on setting up a site-based SharePoint server for use with programs such as WordPerfect. Please refer to this tutorial for general guidance, and then take the following steps for best results with WordPerfect integration.

Step 1: Check your security settings

WordPerfect supports the SharePoint features for Windows Security. Be sure to configure the local domain to allow password authentication for your SharePoint server, which requires Hypertext Transfer Protocol over Secure Socket Layer (HTTPS/SSL) security.

Step 2: Install WordPerfect IFilter & SharePoint Resources

On your SharePoint server, run one of the setups located in the WPRSP folder on the WordPerfect Office X6 DVD: WPRSP.exe (32-bit) or WPRSP_64.exe (64-bit).

This setup installs the WordPerfect IFilter (for detecting and indexing stored WordPerfect documents), along with various other enhancements.
Step 3: Index your WordPerfect documents

For best results, use the SharePoint-server option “Treat similar words with diacritics as different words” when first indexing the stored WordPerfect documents. You can subsequently disable this option, if desired.

Step 4: Deploy SharePoint support

Workstations automatically receive SharePoint integration (and the WordPerfect IFilter) when WordPerfect Office X6 is installed.

If desired, you can deploy the following customized settings:
- disabling of WordPerfect toggle for displaying files in Internet Explorer:
  Use the WPDVIEWLOCK public property (see page 18).
- home page for the Open File dialog box:
  Use the HomePageURL registry key (see page 40).

To extend the SharePoint functions of WordPerfect — for example, to automate multiple check-ins, multiple check-outs, or file-comparison reports — you can use PerfectScript™ macros. The following commands (fully detailed in the installed Macro Help file, psh.chm) will be of interest.

<table>
<thead>
<tr>
<th>To do the following</th>
<th>Use the following commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directly access the document-management engine directly, bypassing its UI</td>
<td>DocMgmtCheckin</td>
</tr>
<tr>
<td></td>
<td>DocMgmtCheckout</td>
</tr>
<tr>
<td></td>
<td>DocSetWorkingFolder</td>
</tr>
<tr>
<td></td>
<td>DocMgmtUndoCheckout</td>
</tr>
<tr>
<td>Access the document-management UI</td>
<td>DocMgmtCheckinDlg</td>
</tr>
<tr>
<td></td>
<td>DocMgmtCheckoutDlg</td>
</tr>
<tr>
<td></td>
<td>DocMgmtDocHistoryDlg</td>
</tr>
<tr>
<td></td>
<td>DocMgmtDocPropertiesDlg</td>
</tr>
<tr>
<td></td>
<td>DocMgmtUndoCheckoutDlg</td>
</tr>
<tr>
<td></td>
<td>DocMgmtVersionCompareDlg</td>
</tr>
<tr>
<td>Specify command arguments (macro-specific values)</td>
<td>DocMgmtGetResultCode</td>
</tr>
<tr>
<td></td>
<td>DocMgmtGetResultDesc</td>
</tr>
<tr>
<td></td>
<td>DocMgmtSetArg</td>
</tr>
<tr>
<td>Specify document properties</td>
<td>DocPropertyGetCount</td>
</tr>
<tr>
<td></td>
<td>DocPropertyGetName</td>
</tr>
<tr>
<td></td>
<td>DocPropertyGetType</td>
</tr>
<tr>
<td></td>
<td>DocPropertyGetValue</td>
</tr>
<tr>
<td></td>
<td>DocPropertyRemove</td>
</tr>
<tr>
<td></td>
<td>DocPropertyRemoveAll</td>
</tr>
<tr>
<td></td>
<td>DocPropertySet</td>
</tr>
</tbody>
</table>
Stage 2: Creating the server image

After preparing for deployment, you’re ready to create the server image.

To create a basic image, you run a standard command line. To create a customized image, you can modify this command line — or you can modify certain aspects of the server image or its setup. If you want to support multiple installation types, you can create multiple server images.

In this stage

Creating a basic image.................................................6
Creating a customized image.......................................8
Creating multiple images...........................................9

Creating a basic image

To create a basic server image, you must initialize the setup. After setting up the image and tweaking it as necessary, you can use it for deployment.

In this section

Initializing the setup..............................................6
Setting up the server image.................................6
Finalizing the server image.................................7

Initializing the setup

To initialize the setup for creating a server image, you use a command line. The following command line lets you create a basic server image from the installation disc (where X: is the disc drive):

X:\Setup\Setup.exe /a

If your deployment scenario requires using msiexec.exe instead of Setup.exe, see page 43.

Event logging

If you want to create a log file of installation events, include the /l switch in your command line. For details on this switch, see page 12.

Limited setup UI

If you want to limit the amount of user interface (UI) encountered when creating a server image, include the /q switch in your command line. For details on this process, see “Limited setup UI” on page 7.

Setting up the server image

If your /a command line succeeds, the setup initializes in one of two ways:
• with full UI — for the standard command line
• with limited (or no) UI — for a command line customized to include /q
Full setup UI

The setup UI takes you step-by-step through the process of setting up the server image. A few notes on this process will suffice.

<table>
<thead>
<tr>
<th>UI component</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>End-User License Agreement (EULA)</td>
<td>To create the server image, you must accept — on behalf of your organization — the terms in the license agreement. Installations deployed from the image will not prompt users to review the license agreement.</td>
</tr>
<tr>
<td>Image Location</td>
<td>Type the full (UNC) path in the box provided, or click the Change button to browse to that location. For best results, limit the path to 70 characters.</td>
</tr>
<tr>
<td>Product Updates</td>
<td>By default, automatic updates are disabled. However, you can choose to have workstations detect and download product updates.</td>
</tr>
</tbody>
</table>

Limited setup UI

If you want to limit the amount of user interface (UI) encountered when creating a server image, include the /q switch in your command line. For details on this switch, see page 13.

Be careful to avoid suppressing (or “silencing”) a required user-interface field when introducing a /q switch into your command line — otherwise, you may fail to create a valid server image. You may need to include the following public properties in your command line:

- **TARGETDIR="path"** — to specify the desired location of the server image. For best results, do not end the path with a backslash (\).
- **ALLOW_PRODUCTUPDATES=0** — to disable automatic updates (and in-product messaging) on the workstations. By default, automatic updates are enabled for workstations installed from a server image.
- additional installation properties supported by the setup. For details, see “Using public properties” on page 13.

Finalizing the server image

This section describes recommended steps to take before deploying from the server image.

Optionally, you can finalize the image in the following ways:

- Customize the registry settings you want to deploy (see page 39).
- Customize the setup fileset (see page 41).
Patching the image  To avoid deploying the software twice, you may want to check for software updates and apply them to the image as necessary. For details, see page 22.

Supporting OOXML  A typical server image of WordPerfect Office X6 includes a folder called MSPack. By downloading the Microsoft® Compatibility Pack from the Microsoft website and saving its executable file (EXE) to this folder, you can deploy support for saving to Office Open XML (OOXML) format from within WordPerfect Office X6. (The installation of the Microsoft Compatibility Pack will take place after the workstation successfully installs WordPerfect Office X6 from the server image.)

Configuring BDE  For WordPerfect and Quattro Pro® to function properly, you must ensure that the network folder settings for the Borland® Database Engine (BDE) point to a folder for which all users have write and delete permissions.

To adjust the Borland Database Engine
1  Log on to the server console as an administrator.
2  From the Windows Control Panel, open the BDE Administrator.
3  Click the Configuration tab.
4  Expand the Configuration tree, and navigate to the following:
   Drivers\Native\PARADOX
5  In the right pane, click the field to the right of the NET DIR entry.
6  Click ..., and browse to the location of the desired network folder.
   All users must have write and delete permissions for this folder.
7  Click Object ➤ Apply.
8  Click OK to confirm the save, and then click OK again when you are prompted to restart all Borland Database Engine applications.

Testing the image  You may want to test your finalized image with a small subset of workstations before rolling it out to your entire organization.

Moving the image  To change the location of a server image after you create it, you must create a new image at a new location. You cannot copy an image from one location to another.

Creating a customized image

If you require a more customized server image than offered by command-line switches (see page 12) and public properties (see page 13), you may want to consider the specialized scenarios discussed in the Appendix.
### MSI files
You can modify the Microsoft Windows Installer (MSI) files used to install the software. See page 37.

### MST files
You can apply Microsoft® transformation (MST) files to the setup. See page 38.

### Registry keys
You can edit the registry settings for the server image. See page 39.

### Setup fileset
You can customize the setup fileset. See page 41.

### Installation settings
You can customize the settings used to install the software on the workstations. See page 43.

---

### Creating multiple images

If your workstations require different configurations of the software, you can create one server image for each installation type.

#### Product updates
When a product update becomes available, you will need to apply it to each server image. For details on image patching, see page 23.

#### Naming convention
Use a naming convention that makes it easy to distinguish the server images from one other.
Stage 3: Installing the software

After creating the server image, you can use it to install the software on the workstations in one of two ways:

• manually, by having users “pull” the software to their own workstations
• automatically, by “pushing” the software to the workstations on their users’ behalf

Pulling the software

If users have both access to the server and administrator-level rights to their workstations, they can install (or “pull”) the software themselves. To do this, they run the setup from the server image.

Preparing for pull installation

To ensure that the pull-installation process runs as smoothly as possible, take the time to prepare for it.

Requirements

• Confirm that each workstation meets the minimum requirements for the software (see “Workstation requirements” on page 3).
• Confirm that each workstation user has read-only access to the server image and administrator-level access to the workstation (see also “Workstation setup” on page 4).

Recommendations

• Map the workstations to the server image, and set the workstations to log in to that server location at startup. Doing so ensures that users are always connected to the server image.
• Confirm that all workstations are running the latest version of Microsoft Windows Installer. Doing so simplifies the installation process.

Carrying out a pull installation

Users pull the software to their workstations by running the setup from the server image.
The degree of user interaction required by the setup depends on how you’ve customized the server image and the deployment process.

If you prefer to restrict user customization, you may want to offer multiple server images — one per set of installation options. For details, see page 9.

To pull the software to a workstation

1. Browse to the location of the server image, and double-click Setup.exe.
2. Carry out the installation, specifying any desired options, by following the on-screen instructions.
   For best results, limit the installation path to 70 characters.

Pushing the software

To “push” the software from the server image to the workstations, you must write a command line that includes the following:

- the filename of the setup you want to use
- any desired switches, to control how the setup runs
- any desired public properties, to specify installation settings

Using this command line, you can install the software on the workstations by using any supported push method.

In this section

Specifying the setup file .............................................. 11
Using switches .......................................................... 12
Using public properties .................................................. 13
Running your command line ......................................... 18

Specifying the setup file

The most important item to specify in your command line is the executable file for the setup: the Setup.exe file on the server image you want to use:

```
\\server\path\Setup.exe
```

If your path contains spaces, you must place quotation marks around it:

```
"\\server\path containing spaces\Setup.exe"
```

If your network requires deployment via msiexec.exe instead of Setup.exe, see page 43.
**Using switches**

By using switches in your command line, you can control the setup process. Listed in this section are the switches most commonly used when installing the software.

For general information on switches, along with details on switch syntax, please “Switches” in the *Corel Beginner’s Guide to Network Deployment*.

For a list of all command-line switches for Microsoft Windows Installer, please see the Microsoft website.

/\ Event logging

Use /l to log installation events.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What it logs</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>Status messages</td>
</tr>
<tr>
<td>w</td>
<td>Nonfatal warnings</td>
</tr>
<tr>
<td>e</td>
<td>All error messages</td>
</tr>
<tr>
<td>a</td>
<td>Initiated actions</td>
</tr>
<tr>
<td>r</td>
<td>Action-specific records</td>
</tr>
<tr>
<td>u</td>
<td>User requests</td>
</tr>
<tr>
<td>m</td>
<td>Error messages for out-of-memory warnings or fatal exits</td>
</tr>
<tr>
<td>o</td>
<td>Error messages for insufficient hard-disk space during server installation</td>
</tr>
<tr>
<td>p</td>
<td>Terminal properties</td>
</tr>
<tr>
<td>*</td>
<td>All of the above, in a single log file</td>
</tr>
</tbody>
</table>

NOTE: Alternatively to /l*, you can use /log.

The default parameters for /l are **iwearmo** ("iwearmo "c:\install Logs.txt").

If you want to specify a path for the log file, use the following syntax:

/\ "path"

If you do not specify a path and filename, the log file is created in the current user’s temporary (Temp) folder.

In the following example, the /l switch (with default parameters) is used to log installation events in the specified file:

\server\path\Setup.exe /l "C:\install.txt"
/q  **Limited setup UI**

Use /q to limit the amount of setup UI encountered during installation.

You can use /q to prevent users from entering their own registration information, to help enforce specific installation options, or even to perform silent installations (in which no setup UI is visible whatsoever).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What the user sees during installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>n</td>
<td>No UI whatsoever. Errors are logged in a file that you can control by using /1 (see page 12). This is the default parameter. NOTE: Alternatively to /qn, you can use /quiet.</td>
</tr>
<tr>
<td>b</td>
<td>Basic UI: a progress bar and a Cancel button. If the user pushes the Cancel button, the installation is rolled back upon confirmation. NOTE: Alternatively to /qb, you can use /passive.</td>
</tr>
<tr>
<td>b!</td>
<td>Basic UI: only a progress bar. The user cannot cancel the installation.</td>
</tr>
<tr>
<td>b+</td>
<td>Basic UI: a progress bar and a Cancel button. If the user pushes the Cancel button, the installation is rolled back (without first prompting for confirmation).</td>
</tr>
<tr>
<td>r</td>
<td>Reduced UI: A progress bar, along with a page containing information about the installation. The user can cancel the installation.</td>
</tr>
<tr>
<td>f</td>
<td>Full UI</td>
</tr>
</tbody>
</table>

The default parameter for /q is n.

In the following example, all setup UI is suppressed, and any errors are recorded in the specified log file:

```
\server\path\Setup.exe /q /l "C:\Logs\My_Log.txt"
```

/?  **Help**

The /? switch (or /help) displays Help for the setup.

**Using public properties**

By using public properties in your command line, you can specify installation settings. Listed alphabetically in this section are the properties most commonly used during software installation.

For general information on public properties, along with details on property syntax, please see the *Corel Beginner’s Guide to Network Deployment*. 
For a list of all command-line properties for Microsoft Windows Installer, please see the Microsoft website.

**ADDLOCAL** Installing specific components

For details on this scenario, see the following topics in the appendix:
- “Deploying specific features” on page 26
- “Deploying specific languages” on page 27

**ASSOCIATE_DOC_FILES** Associate .doc files with WordPerfect

You can associate all Microsoft® Word .doc files with WordPerfect by using the following property:

```
ASSOCIATE_DOC_FILES=1
```

**ASSOCIATE_PPT_FILES** Associate .ppt files with Presentations

You can associate all Microsoft® PowerPoint® .ppt files with Presentations by using the following property:

```
ASSOCIATE_PPT_FILES=1
```

**ASSOCIATE_XLS_FILES** Associate .xls files with Quattro Pro

You can associate all Microsoft® Excel® .xls files with QuattroPro by using the following property:

```
ASSOCIATE_XLS_FILES=1
```

**DESKTOPSHORTCUTS** Opting out of desktop shortcuts

You can prevent the installation of desktop shortcuts by using the following property:

```
DESKTOPSHORTCUTS=0
```

**IGNORE_LAUNCH_CONDITIONS** Suppressing the software-requirements check

By default, the setup checks whether the computer meets the minimum software requirements (see page 3) before proceeding with the installation. To suppress this check, use the following property:

```
IGNORE_LAUNCH_CONDITIONS=1
```

**FORCENOSHOWLIC** Suppressing the EULA prompt

If the software is installed silently (see page 13), each workstation user will be prompted to accept the End-User License Agreement (EULA) at first start-up. To suppress the EULA prompt on the workstations, use the following property:

```
FORCENOSHOWLIC=1
```
If you choose to suppress the EULA prompt on the workstations, you are accepting the terms of the EULA on behalf of all users on your network when you create the server image.

**INSTALL_APP**  Installing only specified programs

By default, WordPerfect Office X6 installs WordPerfect, Quattro Pro, and Presentations™. To install only one (or two) of these programs, use the **INSTALL_APP** property with one of the following values (or two comma-separated values).

<table>
<thead>
<tr>
<th>Value</th>
<th>What it installs</th>
</tr>
</thead>
<tbody>
<tr>
<td>presentations</td>
<td>Presentations</td>
</tr>
<tr>
<td>quattropro</td>
<td>Quattro Pro</td>
</tr>
<tr>
<td>wordperfect</td>
<td>WordPerfect</td>
</tr>
</tbody>
</table>

In the following example, only WordPerfect is installed:

```
Setup.exe INSTALL_APP=wordperfect
```

In the following example, only WordPerfect and Quattro Pro are installed:

```
Setup.exe INSTALL_APP=wordperfect,quattropro
```

You can also install specific program features. For details, see page 26.

**INSTALLDIR**  Customizing the installation path

When deploying from the server image, use the following public property to customize the installation path of the software:

```
INSTALLDIR="path"
```

For best results, do not end the path with a backslash ( \ ).

**INSTALL_IFILTER**  Managing IFilter installation

You can prevent the installation of the WordPerfect IFilter by using the following property:

```
INSTALL_IFILTER=0
```

**MIGRATE_PRODUCT**  Migrating user settings during upgrade

When upgrading from a previous version of WordPerfect Office, you can use the **MIGRATE_PRODUCT** property to migrate user settings. For details on upgrading to WordPerfect Office X6, see page 16.

**REBOOT**  Handling reboots

The **REBOOT** property is used with one of the following values to specify how the installation process handles any required reboots.
SERIAL NUMBER  Inputting your serial number

To input your assigned serial number, use the following property:

```
SERIALNUMBER=serial number
```

You must type the serial number without any spaces.

SPLITTABLEROWS  Splitting table rows

By default, WordPerfect disables the setting for splitting table rows across pages (Table ➤ Format ➤ Row ➤ Divide row across pages) — in part, to ensure that footnotes can be added within tables. To enable this setting on the workstations, use the following property:

```
SPLITTABLEROWS=1
```

Enabling this setting corresponds to writing the registry key

```
WPTablesSpanRows
```

while disabling it corresponds to writing

```
WPTablesSpanRows_defaultOff
```

See page 39 for details on registry keys.

UPGRADE_PRODUCT  and  UPGRADE_PRODUCT_DEFAULT

Upgrading to WordPerfect Office X6

To upgrade to WordPerfect Office X6 and migrate user settings from a previous version of WordPerfect Office, you must use several public properties together.

First, you must use the following property to specify which version (or versions) of WordPerfect Office to search for:

```
UPGRADE_PRODUCT=value
```
The `UPGRADE_PRODUCT` property is used with one (or more) of the following (comma-separated) values:

<table>
<thead>
<tr>
<th>Value</th>
<th>What it searches for</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Any installed version of WordPerfect Office</td>
</tr>
<tr>
<td>15</td>
<td>WordPerfect Office X5</td>
</tr>
<tr>
<td>14</td>
<td>WordPerfect Office X4</td>
</tr>
<tr>
<td>13</td>
<td>WordPerfect Office X3</td>
</tr>
<tr>
<td>12</td>
<td>WordPerfect Office 12</td>
</tr>
</tbody>
</table>
| 11    | WordPerfect Office 11  
|       | NOTE: You cannot upgrade from WordPerfect Office 11 without first uninstalling Paradox® (if included). |
| None  | Nothing — upgrade feature is disabled |

Next, you must use the following public property to specify whether to upgrade the previous version (or versions) of WordPerfect Office found:

`UPGRADE_PRODUCT_DEFAULT=value`

The `UPGRADE_PRODUCT_DEFAULT` property is used with one of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>On (or any other value)</td>
<td>Automatically upgrades all installed versions of WordPerfect Office</td>
</tr>
<tr>
<td>Off</td>
<td>Does not automatically upgrade any installed version of WordPerfect Office</td>
</tr>
</tbody>
</table>

To upgrade to WordPerfect Office X6, you must use `UPGRADE_PRODUCT` and `UPGRADE_PRODUCT_DEFAULT` together. Using only one property causes it to be ignored altogether.

Finally, you can use the following public property to migrate user settings from a previous version of WordPerfect Office:

`MIGRATE_PRODUCT=value`

The `MIGRATE_PRODUCT` property is used with one of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Where it migrates settings from</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latest</td>
<td>The latest installed version of WordPerfect Office</td>
</tr>
<tr>
<td>15</td>
<td>WordPerfect Office X5</td>
</tr>
<tr>
<td>14</td>
<td>WordPerfect Office X4</td>
</tr>
</tbody>
</table>
In the following example, all installed versions of WordPerfect Office are automatically upgraded to WordPerfect Office X6, and user settings are migrated from the latest installed version of WordPerfect Office:

```
UPGRADE_PRODUCT=All  UPGRADE_PRODUCT_DEFAULT=On
MIGRATE_PRODUCT=Latest
```

In the following example, only WordPerfect Office 12 and WordPerfect Office X3 are searched for — but they are not automatically upgraded to WordPerfect Office X6; in addition, user settings are migrated from WordPerfect Office 12:

```
UPGRADE_PRODUCT=12,13  UPGRADE_PRODUCT_DEFAULT=Off
MIGRATE_PRODUCT=12
```

**USERNAME**  **Inputting the user name**

To input the user name for the installation, use the following property:

```
USERNAME="user name"
```

**WPDVIEWLOCK**  **Locking the display of WPD files in Internet Explorer**

By default, users have access to the following WordPerfect setting: 

> Tools ➤ Settings ➤ Files ➤ Allow Internet Explorer to display WPD files. To make this setting unavailable, use the following property:

```
WPDVIEWLOCK=1
```

Making this setting unavailable corresponds to writing the registry key WPWinViewerLocked. For details on registry keys, see page 39.

### Running your command line

Your command line can be used to push the software to the workstations through any of the following:

- **a batch file** — see the Microsoft website for details
- **a GPO** — see the Group Policy SDK for details
- **a third-party push technology** — see the manufacturer’s documentation for details
For many administrators, using a third-party push technology is the preferred push method. This section offers general guidelines on using a few such technologies.

**SCCM** At the time of this writing, Corel has verified support for Microsoft® System Center Configuration Manager (SCCM) only insofar as its Microsoft Systems Management Server (SMS) components.

For complete information on using SCCM, please see the Microsoft website.

**SMS** For deployment to the workstations on a “per-system” basis using package definition files (or “packages”), WordPerfect Office X6 supports the use of Microsoft Systems Management Server (SMS).

You can create a package from scratch — or you can create one from the existing SMS file included with WordPerfect Office X6 (in the Administrator folder on the installation disc or the server image).

For complete information on using SMS files, please refer to your resource kit for Microsoft Systems Management Server.

The recommendations posted on the Microsoft website have not been tested with WordPerfect Office X6 and must therefore be used at your discretion.

**IntelliMirror** For deployment to the workstations, WordPerfect Office X6 supports the use of the IntelliMirror technology, which is part of the Windows Server 2003, Windows Server 2008, and Windows Server 2008 R1 operating systems.

“Per-user” installations are not supported.

To make deployment with IntelliMirror as easy as possible, WordPerfect Office X6 includes a ZAP file (in the Administrator folder on the installation disc or the server image).

For complete information on IntelliMirror, please see the Microsoft website.
Stage 4: Maintaining the installations

An important part of administering a network is maintaining the software installed on its workstations.

In this stage

- Repairing the software ........................................... 20
- Modifying the software ............................................ 22
- Updating the software .............................................. 22
- Removing the software .............................................. 24
- Troubleshooting the software ................................. 25

Repairing the software

Repairing the software lets you install (or reinstall) missing (or corrupted) components. You can repair a single installation of the software by using the Windows Control Panel on that workstation, or you can repair multiple workstation installations by using a command line.

Repairing a single installation

You can use the Windows Control Panel to repair a single installation.

To repair an installation with the Windows Control Panel

1 In the Windows Control Panel, display the list of currently installed programs, and choose the program from the list.
2 Click Uninstall/Change (for Windows 7 or Windows Vista) or Change/Remove (for Windows XP).
3 Enable the Repair option, and then click Repair.
4 Follow the on-screen instructions.

Repairing multiple installations

You can use a command line to repair multiple installations at a time.

/f Basic repair

Use the /f switch with the Setup.exe file on the server image:

\\server\path\Setup.exe /f

You cannot use the /f switch with public properties. For greater control over the repair process, use the REINSTALL and REINSTALLMODE properties instead of /f.
The \(/f\) switch has the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>p</td>
<td>Reinstalls missing files</td>
</tr>
<tr>
<td>o</td>
<td>Reinstalls missing files and files older than current version</td>
</tr>
<tr>
<td>e</td>
<td>Reinstalls missing files and files equal to or older than current version</td>
</tr>
<tr>
<td>d</td>
<td>Reinstalls missing files and files different from current version</td>
</tr>
<tr>
<td>a</td>
<td>Reinstalls all files</td>
</tr>
<tr>
<td>u</td>
<td>Reinstalls all required user-specific registry keys: (HKEY_CURRENT_USER, HKEY_USERS)</td>
</tr>
<tr>
<td>m</td>
<td>Reinstalls all required computer-specific registry keys: (HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT)</td>
</tr>
<tr>
<td>s</td>
<td>Reinstalls all existing shortcuts</td>
</tr>
<tr>
<td>v</td>
<td>Runs from the source files and re-caches the local package</td>
</tr>
</tbody>
</table>

The default parameters for \(/f\) are \(oums\).

**Advanced repair**

For greater control over how the software is repaired, use the \(\text{REINSTALL}\) and \(\text{REINSTALLMODE}\) public properties together.

<table>
<thead>
<tr>
<th>Property</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>(\text{REINSTALL=ALL})</td>
<td>Reinstalls all program features. If you prefer to reinstall only specific features (see page 26 for a list), use the following syntax: (\text{REINSTALL=Feature})</td>
</tr>
<tr>
<td>(\text{REINSTALLMODE=type})</td>
<td>Specifies the type of reinstallation to perform. The values for this property are the same as the parameters for the (/f) switch, so its default values are (oums).</td>
</tr>
</tbody>
</table>
Modifying the software

Modifying the software lets you change which program features are installed. You can modify a single installation of the software by using the Windows Control Panel on that workstation, or you can modify multiple workstation installations by using a command line.

Modifying a single installation

You can use the Windows Control Panel to modify a single installation.

To modify an installation with the Windows Control Panel

1 In the Windows Control Panel, display the list of currently installed programs, and choose the program from the list.
2 Click Uninstall/Change (for Windows 7 or Windows Vista) or Change/ Remove (for Windows XP).
3 Enable the Modify option, and then click Next.
4 Follow the instructions that appear.

Modifying multiple installations

You can use a command line to modify multiple installations at a time.

REINSTALL and REINSTALLMODE

Adding features

You can use the REINSTALL and REINSTALLMODE properties to add program features. For details on these properties, see page 21.

REMOVE

Removing features

You can use the REMOVE public property to remove a program feature:

REMOVE=Feature

For more than one feature, use a comma-separated list:

REMOVE=Feature1,Feature2

For a list of available features, see page 26.

Updating the software

Corel periodically releases Microsoft patch (MSP) files — or “patches” — for its products. Installing patches helps keep the software up-to-date.
In this guide, `Patch.exe` is a placeholder for the filename of the patch. The actual filename varies with each patch.

### Locating patches

Many network administrators keep their software up-to-date by monitoring the Corel Support Services website (www.corel.com/support). When a patch is made available, these administrators download it and carry out the patching process themselves.

In this guide, `\\server\path\Patch.exe` is a placeholder for the location and filename of the downloaded patch.

If you prefer to have workstation users patch the software for themselves, you can set up the server image to enable the automatic detection of available patches. For details, see “Setting up the server image” on page 6.

### Applying patches

After locating and downloading a patch, you can apply it to the server image and then use the updated image to patch the installed software.

#### Image patching

You can apply a patch to the server image. Optionally, you can begin by extracting the patch files to a specified location.

**To extract the patch files to a specified location**

To extract the patch files to a specified location (instead of the default Temp folder), use the following command-line syntax:

`\\server\path\Patch.exe /extract_all "location"

Be sure to apply all extracted patch files to the server image. Applying only some of the patch files may cause the installations to function incorrectly.

**To apply the patch files to the server image**

Use a command line that includes the executable file for the patch and the /a switch:

`\\server\path\Patch.exe /a`

If necessary, you can include the location of the server image:

`\\server\path\Patch.exe /a "\\server\path\Setup.exe"

#### Workstation patching

After patching the server image, you can deploy the update to the workstations.
To patch the workstations

Use the following command-line syntax:

```
\server\path\Setup.exe REINSTALL=ALL
```

By default, the REINSTALLMODE=oums property is applied. For best results, you may want to specify REINSTALLMODE=vdm:

```
\server\path\Setup.exe REINSTALL=ALL
REINSTALLMODE=vdm
```

For details on REINSTALL (and REINSTALLMODE), see page 21.

To silently patch the workstations

Use the following command line:

```
\server\path\Patch.exe /s
```

For best results, avoid silently patching the workstations.

---

Removing the software

You can remove the software from your network. Uninstalling the software cleanly is crucial when the time comes to upgrade to a newer version.

**Image removal**

You cannot automate the removal of a server image. Instead, you must manually delete the image from the server.

For best results with deleting an image, begin by doing the following:

- Make sure that the programs to be removed — and their associated files — are not currently in use on the workstations.
- If you are using Windows Terminal Server, make sure that all users are logged off.

The only way to re-cover a deleted server image is to re-create it by re-running the setup.

**Workstation removal**

You can remove a single installation of the software by using the Windows Control Panel on that workstation, or you can remove multiple workstation installations by using a command line.

**Removing a single installation**

You can use the Windows Control Panel to remove a single installation.
To remove an installation with the Windows Control Panel

1 In the Windows Control Panel, display the list of currently installed programs, and choose the program from the list.

2 Click Uninstall/Change (for Windows 7 or Windows Vista) or Change/Remove (for Windows XP).

3 Enable the Remove option.

4 If you want to remove user files (such as presets, user-created fills, and customized files), enable the Remove user files check box.

5 Click Remove.

Removing multiple installations

You can use a command line to remove multiple installations at a time.

/x Basic removal

You can use the /x switch (or the /uninstall switch) to silently remove the software:

```
\server\path\Setup.exe /x
```

Advanced removal

If you want more control over the removal process, use the following two public properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>REMOVE=ALL</td>
<td>Removes all features</td>
</tr>
<tr>
<td>REMOVEUSERFILES=value</td>
<td>Specifies whether to remove user files:</td>
</tr>
<tr>
<td></td>
<td>• 0 — no</td>
</tr>
<tr>
<td></td>
<td>• 1 — yes</td>
</tr>
</tbody>
</table>

Troubleshooting the software

For help troubleshooting any issues with the software, please visit the Corel® Knowledge Base™ (www.corel.com/knowledgebase), an online repository of FAQs and articles.
Appendix: Specialized deployment scenarios

If you require a more specialized deployment scenario, the supplementary topics in this appendix may be of interest to you.

In this appendix

- Deploying specific features ................................................. 26
- Deploying specific languages ............................................. 27
- Deploying Paradox ............................................................ 29
- Deploying macros and templates ......................................... 33
- Working with MSI files ....................................................... 37
- Working with MST files ....................................................... 38
- Working with registry keys ................................................. 39
- Customizing the setup fileset .............................................. 41
- Deploying customized installation settings ......................... 43
- Deploying the software with msiexec.exe ......................... 43

Deploying specific features

When performing a basic or silent installation with the /q switch (see page 13), you may want to use the ADDLOCAL property to specify which software features to install. You can specify a single feature:

```
ADDLOCAL=Feature
```

Or you can specify a comma-separated list of components:

```
ADDLOCAL=Feature1,Feature2
```

You can even specify all features:

```
ADDLOCAL=ALL
```

If you want to install nearly all features, naming them individually would be quite tedious. In this scenario, you can use the REMOVE public property to specify the features to subtract from ADDLOCAL=ALL:

```
ADDLOCAL=ALL REMOVE=Feature1,Feature2
```

Feature names are case-sensitive.

Specifying software features by feature name

You can specify individual WordPerfect Office X6 components by their feature name.

Some editions of the software do not include certain features listed in this section.
Feature names are case-sensitive.

<table>
<thead>
<tr>
<th>WPO component</th>
<th>Feature name</th>
</tr>
</thead>
<tbody>
<tr>
<td>WordPerfect</td>
<td>WP</td>
</tr>
<tr>
<td>QuattroPro</td>
<td>QP</td>
</tr>
<tr>
<td>Presentations</td>
<td>PR</td>
</tr>
<tr>
<td>WordPerfect® Lightning™</td>
<td>LT</td>
</tr>
<tr>
<td>Support for document display in Web browser</td>
<td>WPBrowse</td>
</tr>
<tr>
<td>Borland Database Engine 5.2</td>
<td>UtBDE</td>
</tr>
<tr>
<td>Support for document display in Web browser</td>
<td>WPBrowse</td>
</tr>
<tr>
<td>QuickFinder</td>
<td>UtQFind</td>
</tr>
<tr>
<td>Conversion Utility</td>
<td>UtWPConv</td>
</tr>
<tr>
<td>Clipbook</td>
<td>UtClipbk</td>
</tr>
</tbody>
</table>

### Deploying specific languages

When performing a basic or silent installation with the /q switch (see page 13), you may want to use the ADDLOCAL property to specify which software languages to support. You can specify a single language:

```
ADDLOCAL=LanguageCode
```

Or you can specify a comma-separated list of languages:

```
ADDLOCAL=FEATURE1,LanguageCode1,LanguageCode2
```

Using language codes, you can specify writing tools.

Some editions of the software do not include certain languages listed in this section.

Language codes are case-sensitive.

### Specifying writing tools by language code

Each set of writing tools includes Spell Checker and may include Thesaurus or Grammatik (or both). The available languages are as follows.

<table>
<thead>
<tr>
<th>Language</th>
<th>Code</th>
<th>Spell Checker</th>
<th>Thesaurus</th>
<th>Grammatik</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afrikaans</td>
<td>Afrika</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
<td>Spell Checker</td>
<td>Thesaurus</td>
<td>Grammatik</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>---------------</td>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td>Catalan</td>
<td>Catalan</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Czech</td>
<td>Czech</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Danish</td>
<td>Danish</td>
<td>✓  ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dutch</td>
<td>Dutch</td>
<td>✓  ✓  ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>English</td>
<td>English</td>
<td>✓  ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finnish</td>
<td>Finnish</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>French</td>
<td>French</td>
<td>✓  ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Galician</td>
<td>Galician</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>German</td>
<td>German</td>
<td>✓  ✓  ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Greek</td>
<td>Greek</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Icelandic</td>
<td>Iceland</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italian</td>
<td>Italian</td>
<td>✓  ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Norwegian</td>
<td>Norway</td>
<td>✓  ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polish</td>
<td>Polish</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Portuguese</td>
<td>Portuguese</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Russian</td>
<td>Russian</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slovak</td>
<td>Slovak</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sotho</td>
<td>Sotho</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spanish</td>
<td>Spanish</td>
<td>✓  ✓  ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Swedish</td>
<td>Swedish</td>
<td>✓  ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tswana</td>
<td>Tswana</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Turkish</td>
<td>Turkish</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Xhosa</td>
<td>Xhosa</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zulu</td>
<td>Zulu</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Deploying Paradox

You can make Paradox available on the workstations only if it is included in your version of WordPerfect Office. However, please note that the process for deploying Paradox is separate from the process for deploying WordPerfect Office.

You can deploy Paradox regardless of whether you’re deploying WordPerfect Office. However, if you want to deploy both, you must deploy WordPerfect Office first and Paradox second.

For an overview of the deployment process for WordPerfect Office, please see “Stage 1: Preparing for deployment” on page 2.

Creating the server image for Paradox

The process for creating a server image of Paradox is similar to the process for creating a server image of WordPerfect Office. Follow the procedures given on page 6 for creating a server image, but be sure to use the Paradox setup rather than the one for WordPerfect Office.

Deploying Paradox to the workstations

The process for deploying Paradox to the workstations is similar to the process for deploying WordPerfect Office — just be sure to use the Paradox installation files rather than the ones for WordPerfect Office. Default installation files are provided with the Paradox setup.

If you want to specify individual features in your command line, see “Paradox command-line features” on page 30.

For information on pulling software to the workstations, see “Pulling the software” on page 10.

For information on pushing software to the workstations, see “Pushing the software” on page 11.

Optimizing the installed software

To optimize the installed software, you must refresh the New from project template list in PerfectExpert.

In addition, in order for Paradox to function properly, you must ensure that the network-folder settings for Borland Database Engine points to a folder for which all users have write and delete permissions.
To refresh the PerfectExpert template list
1. Click File > New from project.
2. In the PerfectExpert dialog box, click Options > Refresh project.

To change the network-folder settings
1. After installation, log on to the server console as an administrator.
2. From the Windows Control Panel, open the BDE Administrator.
3. Click the Configuration tab.
4. Expand the Configuration tree, and navigate to Drivers\Native\PARADOX.
5. In the right pane, click the field to the right of the NET DIR entry.
6. Click ..., and browse to the location that you have chosen as the network folder.
7. All users must have write and delete permissions on this folder.
8. Click Object > Apply.
9. Click OK to confirm the save, and then click OK again when you are prompted to restart all Borland Database Engine applications.

Maintaining the software
The process for maintaining the installed Paradox software is similar to the process for maintaining the installed WordPerfect Office software — just be sure to use the Paradox installation files rather than the ones for WordPerfect Office. Default installation files are provided with the Paradox setup.

For information on maintaining software, see “Updating the software” on page 22.

Paradox command-line features
This section outlines the command-line features available for Paradox.

Features are available for the following Paradox components:
- Paradox
- Borland Database Engine
- Filters
- Templates and sample tables
- Writing tools

For a list of available public properties, see page 13.
- Remember that feature names are case-sensitive.

Paradox
The Paradox feature installs the main program file for Paradox and all related files that are essential for running Paradox.
Borland Database Engine

The Borland Database Engine feature installs the files that are required to run Borland Database Engine version 5.2.

Feature filters

The Filters feature lets you install the following parent features:

- **GraphicsConversions** — installs the graphics-conversion filters
- **Spreadsheets** — installs the spreadsheet filters
- **TextConversions** — installs the text-conversion filters
- **WordProcessors** — installs the word-processor filters

Graphics-conversion filters

The GraphicsConversions parent feature contains two sets of graphics-conversion filters: **BitmapGraphicConversions** and VectorGraphicConversions.

The BitmapGraphicConversions feature contains the following bitmap-conversion filters.

<table>
<thead>
<tr>
<th>Bitmap-conversion filter</th>
<th>Feature name</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP conversion</td>
<td>BMP</td>
</tr>
<tr>
<td>CAL conversion</td>
<td>CAL</td>
</tr>
<tr>
<td>CPT conversion</td>
<td>CPT</td>
</tr>
<tr>
<td>GIF conversion</td>
<td>GIF</td>
</tr>
<tr>
<td>ICO/COR conversion</td>
<td>ICOCOR</td>
</tr>
<tr>
<td>IMG conversion</td>
<td>IMG</td>
</tr>
<tr>
<td>JPEG conversion</td>
<td>JPEG</td>
</tr>
<tr>
<td>MAC conversion</td>
<td>MAC</td>
</tr>
<tr>
<td>PCD conversion</td>
<td>PCD</td>
</tr>
<tr>
<td>PCT conversion</td>
<td>PCT</td>
</tr>
<tr>
<td>PCX conversion</td>
<td>PCX</td>
</tr>
<tr>
<td>PNG conversion</td>
<td>PNG</td>
</tr>
<tr>
<td>PP4 conversion</td>
<td>PP4</td>
</tr>
<tr>
<td>PSD conversion</td>
<td>PSD</td>
</tr>
<tr>
<td>SCT conversion</td>
<td>SCT</td>
</tr>
<tr>
<td>TGA conversion</td>
<td>TGA</td>
</tr>
<tr>
<td>TIFF conversion</td>
<td>TIFF</td>
</tr>
</tbody>
</table>
The **VectorGraphicConversions** feature contains the following vector-conversion filters.

<table>
<thead>
<tr>
<th>Vector-conversion filter</th>
<th>Feature name</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDR/CMX/CCX conversion</td>
<td>CDRCCX</td>
</tr>
<tr>
<td>CDT conversion</td>
<td>CDT</td>
</tr>
<tr>
<td>CGM conversion</td>
<td>CGM</td>
</tr>
<tr>
<td>DRW conversion</td>
<td>DRW</td>
</tr>
<tr>
<td>DXF conversion</td>
<td>DXF</td>
</tr>
<tr>
<td>EMF conversion</td>
<td>EMF</td>
</tr>
<tr>
<td>EPS conversion</td>
<td>EPS</td>
</tr>
<tr>
<td>HPGL/PLT conversion</td>
<td>HPGLPLT</td>
</tr>
<tr>
<td>PIC conversion</td>
<td>PIC</td>
</tr>
<tr>
<td>SVG/XML conversion</td>
<td>SVGXML</td>
</tr>
<tr>
<td>WMF conversion</td>
<td>WMF</td>
</tr>
<tr>
<td>WPG conversion</td>
<td>WPG</td>
</tr>
</tbody>
</table>

**Spreadsheet filters**

The **Spreadsheets** feature contains the following feature:

*MicrosoftExcel*, which installs the Microsoft® Excel® spreadsheet filter.

**Text-conversion filters**

The **TextConversions** feature contains the following text-conversion filters.

<table>
<thead>
<tr>
<th>Text-conversion filter</th>
<th>Feature name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII export</td>
<td>ASCIIExport</td>
</tr>
<tr>
<td>Unicode® export</td>
<td>UnicodeExport</td>
</tr>
</tbody>
</table>

**Word-processor filters**

The **WordProcessors** feature contains the following word-processor filters.
Deploying macros and templates

Macros and templates make it easy to customize solutions for your organization. You can customize a macro that carries out a set of actions, assign that macro to a shortcut key, and save the macro and its shortcut key to a template, so that users who work from that template have access to the macro and its shortcut key.
If you want, you can make customized macros available to workstation users by storing them in a template. In fact, you can store every macro in the default template file ($wp16$$wpt$, where $$ is the default writing-tools language), and then deploy that default template file to each user’s machine.

Template macros are not transferred to documents based on that template. Consequently, template macros are available only when their template is available, so it is important to choose a final location for a template before you put it into active use.

WordPerfect Office X6 supports using a centralized, network-based repository for storing your macros and templates. However, you can deploy macros and templates if preferred.

**Deployment methods**

You can deploy macros and templates as you would any other file:

- by running a specialized command line, such as with a push technology (see page 11)
- by using an MST file (see page 38)
- by customizing the setup fileset (see page 41)

**Installing macros and templates**

At any point, users can install macros and templates to their workstations. Template macros set as read-only do not run properly.

**Default items**

By default, WordPerfect Office installs macros and templates at the following location (where X: is the drive where WordPerfect Office is installed, and where $$ is the installation language):

```
X:\Program Files\Corel\WordPerfect Office X6\Languages\$$\Template\Custom ProgramName templates
```

**User-created items**

User-created macros and templates are stored at the following location (where X: is the drive where the operating system is installed):

- Windows 7 and Windows Vista:
  
  ```
  X:\Users\UserName\AppData\Roaming\Corel\PerfectExpert\16\Language\Custom ProgramName Templates
  ```

- Windows XP:
  
  ```
  X:\Documents and Settings\UserName\Application Data\Corel\PerfectExpert\16\Language\Custom ProgramName Templates
  ```

If a new WordPerfect template doesn’t appear after it is installed to the PerfectExpert or saved to the Custom WP Templates folder, you must refresh the PerfectExpert.
To refresh the PerfectExpert
1 In WordPerfect X6, click File ➤ New from project.
2 Click the Create new tab.
3 Click Options, and then click Refresh projects.
   If the new template still does not appear, try changing the category from [WordPerfect] to Custom WP templates.

Migrating macros and templates

Macros and templates can be migrated from an earlier version of WordPerfect.

Macro migration
Most macros from a previous version of WordPerfect can be recompiled to work in WordPerfect X6.

By default, warnings are not displayed for obsolete tokens because they do not interfere with the functioning of most macros. You can choose to display these warnings, however.

If you want to store your organization’s macros in a centralized repository, you can set WordPerfect to compile and run all macros locally (that is, from the user’s temporary folder). For details, see “To specify how WordPerfect runs and compiles macros” in the WordPerfect Help.

To manually migrate a macro
1 Copy the macro to your template folder (if you haven’t already done so).
2 Start WordPerfect X6.
3 Click Tools ➤ Macro ➤ Edit.
4 Navigate to the macro, select it, and then click Edit.
5 Click the end of the first line.
6 Press the Spacebar, and then press Backspace.
7 Click Save & compile.
   The macro is recompiled for WordPerfect X6. Be sure to correct any errors incurred — often, such errors result from updated or removed commands.

To display warnings for obsolete tokens
1 Click Start ➤ Programs ➤ WordPerfect Office X6 ➤ Utilities ➤ PerfectScript.
2 In PerfectScript, click Tools ➤ Settings.
3 On the Compile page, enable the Warn when using unsupported features check box.
4 Click Apply, and then click OK.
Template migration

Default templates — and most other templates — from previous versions of WordPerfect can be migrated to WordPerfect X6.

Using a migrated template can prevent WordPerfect X6 from displaying its new features. For best results, migrate only the desired template components (toolbars, menus, keystroke assignments, and so on).

When you open a template, WordPerfect checks whether the template is missing default menu commands. You can merge missing menu commands into a template by following the procedure “To merge default menu commands into a template” in the WordPerfect Help.

To manually migrate template components

1. Do one of the following:
   - Copy the source templates to your template folder for WordPerfect Office X6, and then start WordPerfect X6.
   - Start WordPerfect X6. Click Tools ➤ Settings, and then click Files. On the Template page, use the Additional template folder box to specify the location of the source templates.

2. Click Tools ➤ Settings, and then click Customize.

3. Click the tab for the template component you want to migrate.

4. Click Copy, and then do the following:
   - From the Template to copy from list box, choose the source template.
   - From the Select toolbars to copy list, select the component to migrate. Hold down CTRL to select multiple components.
   - From the Template to copy to list box, choose the target template. (If you want, you can choose the default template.)
   - Click OK.

   You are prompted to rename a component if another component by that name exists. To distinguish between similar components, you may want to append version numbers to their names.

5. To apply the new component, enable its check box.

6. To migrate each additional component, repeat steps 3 to 5.

Migrating user settings

In push-installation scenarios, administrators can migrate users’ customized settings automatically (see page 16). In pull-installation scenarios, users themselves can choose to migrate their settings.
QuickWords list  Locate the QuickWords™ list file that belongs to the previous version, and use it to replace the QuickWords list file for WordPerfect X6. The QuickWords list file for WordPerfect X6 is saved at the following location (where $X$: is the drive where Windows is installed and $$ is the default writing-tools language).

- Windows 7 and Windows Vista:
  $X:\Users\UserName\AppData\Roaming\Corel\PerfectExpert\16\Language\Custom WP Templates\QW16$$\$.WPT
- Windows XP:
  $X:\Documents and Settings\UserName\Application Data\Corel\PerfectExpert\16\Language\Custom WP Templates\QW16$$\$.WPT

QuickCorrect list  Locate the QuickCorrect™ list file that belongs to the previous version, and use it to replace the QuickCorrect list file for WordPerfect X6. The QuickCorrect list file for WordPerfect X6 is saved at the following location (where $X$: is the drive where Windows is installed and $$ is the default writing-tools language).

- Windows 7 and Windows Vista:
  $X:\Users\UserName\Documents\Corel User Files\WT16$$\$.UWL
- Windows XP:
  $X:\Documents and Settings\UserName\My Documents\Corel User Files\WT16$$\$.UWL

Address Books  First, export the Address Books from the previous version of WordPerfect to an ABX (version 8) or TXT file format. Then, in WordPerfect X6, create an empty Address Book and import the ABX or TXT file into it.

---

**Working with MSI files**

Stored at Setup\WPO on the installation disc, the main Microsoft Windows Installer (MSI) file for the setup — Setup.msi — contains a database of all features, registry keys, folders, and shortcuts for the software.

The server image contains a copy of the main setup MSI file — the MSI tables within which you can modify for deployment to the workstations.

Various components of the software are stored in additional MSI files. Some of these MSI files are required by the setup, while others represent optional features of the software.

You can exclude optional MSI files from the setup by creating a customized server image. Excluding an MSI file prevents the corresponding feature from being installed. For details, see page 37.
Setup files
Besides Setup.msi, the setup requires additional MSI files to carry out the installation. These required MSI files include the following:

Language modules
The setup requires at least one language module, MSI files for which are stored at Setup\WPO16 on the installation disc. The language modules that are available vary with each edition of the software.

<table>
<thead>
<tr>
<th>Language module</th>
<th>MSI file</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>EN.msi</td>
</tr>
<tr>
<td>French</td>
<td>FR.msi</td>
</tr>
</tbody>
</table>

Programs
To install the programs included with the software, the setup uses the following MSI files at Setup\WPO16 on the installation disc.

<table>
<thead>
<tr>
<th>Program</th>
<th>MSI file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentations</td>
<td>$$PR.msi (where $$ is the setup language)</td>
</tr>
<tr>
<td>Quattro Pro</td>
<td>$$QP.msi (where $$ is the setup language)</td>
</tr>
<tr>
<td>WordPerfect</td>
<td>$$WP.msi (where $$ is the setup language)</td>
</tr>
<tr>
<td>WordPerfect Lightning</td>
<td>Multiple: See the Lightning folder.</td>
</tr>
</tbody>
</table>

Features
To install the various components of the software, the setup uses additional MSI files stored at Setup\WPO16. These files include the following.

<table>
<thead>
<tr>
<th>Feature</th>
<th>MSI file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Migration Manager</td>
<td>MMan_$$ .msi (where $$ is the setup language)</td>
</tr>
<tr>
<td>PerfectExpert</td>
<td>$$PExp.msi (where $$ is the setup language)</td>
</tr>
</tbody>
</table>

---

**Working with MST files**

If you want to apply a Microsoft transformation (MST) file to the setup, simply apply it to your command line.

By default, MST files are applied to the Setup.msi file for the setup.

**To apply a transformation to the setup**

1. Store the MST file on the server image.
2 Use the TRANSFORMS property to specify that MST file, as shown here (where MST is the filename of the MST file):

```
Setup.exe TRANSFORMS="MST"
```

If the MST file is not in the same folder as Setup.exe, MST must specify the full path and filename of the MST file.

### Applying a transformation to a specific MSI file

To apply an MST file to a specific MSI file, use the following syntax (where MSI is the filename of the MSI file, not including its extension; and where MST is the filename of the MST file, including its extension):

```
Setup.exe TRANSFORMS_MSI="MST"
```

If the MST file is not in the same folder as the MSI file, MST must specify the full path and filename of the MST file.

**Example 1**

To apply my_wp.mst to WP.msi (in the same folder), use the following syntax:

```
Setup.exe TRANSFORMS_WP="my_wp.mst"
```

**Example 2**

To apply MyTransform.mst to ENPExp.msi (in the same folder), use the following syntax:

```
Setup.exe TRANSFORMS_ENPExp="MyTransform.mst"
```

### Troubleshooting MST files

If you have trouble applying an MST file, do the following:

- Check the syntax of your command line — in particular, the path to the MST file.
- Check your permissions.
- Make sure that the MST file was created correctly.
- Check the associated MSI files.

For additional help with MST files, contact Corel Support Services (www.corel.com/support). Please note, however, that charges will apply.

### Working with registry keys

After creating the server image, you may want to edit its registry keys for deployment to the workstations. By doing so, you can avoid having to manually configure the registry keys of each individual workstation installation of the software.
Deploying program defaults

When a workstation user first starts a WordPerfect Office X6 program, settings for that program are pushed from HKEY_LOCAL_MACHINE registry keys to HKEY_CURRENT_USER keys for that user. If you want to mandate the default program settings for all workstation users, you can deploy the HKEY_LOCAL_MACHINE registry keys for those settings.

You can use a local installation of WordPerfect Office X6 to determine which HKEY_LOCAL_MACHINE registry keys are affected by a specific program setting. Open the program, and specify the setting that you want to deploy to the workstations. This setting is saved as a value for a specific registry key at the following location:

```
HKEY_CURRENT_USER\Software\Corel\ProgramName\16
```

To deploy this program setting to all workstation users, apply it to the registry file (or MSI table) for the server image as a value for the corresponding HKEY_LOCAL_MACHINE registry key at the following location:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Corel\Setup\WordPerfect Suite\16\Migrate\Software\Corel\ProgramName\16
```

The method described in this section can be used to deploy almost any registry key for WordPerfect Office X6. Two common examples follow.

For best results, do not use this method to deploy file paths.

---

**Shadow Cursor setting**

The Shadow Cursor setting for WordPerfect is stored at the following location for each workstation user:

```
HKEY_CURRENT_USER\Software\Corel\WordPerfect\16\Shadow Cursor
```

To deploy the same Shadow Cursor setting to each user, you must copy the value of the HKEY_CURRENT_USER registry key for that setting ("Shadow Cursor State" = setting) to the following HKEY_LOCAL_MACHINE registry key for the server image:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Corel\Setup\WordPerfect Suite\16\Migrate\Software\Corel\WordPerfect\16\Shadow Cursor
```

---

**Open File home page**

The Web Mode view of the Open file dialog box can be customized to use a specified folder as its home page. Users can specify this home page by clicking the Web mode icon in the Open file dialog box, browsing to the desired folder, and clicking Internet ▶ Set home page. This home-page setting is stored as a value ("HomePageURL" = "URL") of the following registry key for each user:

```
HKEY_CURRENT_USER\Software\Corel\PerfectFit\16\Virtual Namespaces\Internet
```
Specify the **HomePageURL** value for the following registry key for the server image:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Corel\Setup\WordPerfect Suite\16\Migrate\Software\Corel\PerfectFit\16\Virtual Namespaces\Internet
```

---

**Customizing the setup fileset**

The main configuration file `Setup.xml`, located in the x86 or x64 folder, lists all features included in the setup.

When you create a server image, a copy of the `Setup.xml` file is included. If you want to customize the setup fileset on the server image, you must edit the `Setup.xml` file to reflect your desired changes.

**Understanding Setup.xml**

The `Setup.xml` file contains four main types of nodes. With an understanding of these four nodes, you can modify the `Setup.xml` file to create a customized server image.

**<Msi/> nodes**

Each `<Msi/>` node specifies a main setup file, such as an executable (EXE) file, a self-extracting ZIP file, or an MSI file that bundles (or “chains”) other MSI files.

**<Dbm/> nodes**

Each `<Dbm/>` node specifies a component of a `<Msi/>` node — typically, an MSI file. A `<Dbm/>` node has the following structure, where `GUID` is the associated GUID, `MSI` is the path and filename of the MSI file, and `name` is a descriptive name for the MSI file:

```
<Dbm productcode="{GUID}" file="MSI" progresstext="Str.ProgressText.name" />
```

Some `<Dbm/>` nodes also require a condition.

If you want to apply an MST file to the specified MSI file, you can use the following syntax (where `MST` is the path and filename of the MST file):

```
<Dbm productcode="{GUID}" file="MSI" cmdline="TRANSFORMS=MST" progresstext="Str.ProgressText.name" />
```

For a list of the available MSI files, see page 37.
<Feature/> nodes
Each <Feature/> node specifies a feature that is associated with an MSI file. A <Feature/> node has the following format, where name is the name of the MSI file and feature is the name of the associated feature:

```
<Feature name="Str.Feature.name" desc="Str.Feature.name.Desc" property="feature">
```

Some <Feature/> nodes have subnodes.

For a list of the available features, see page 26.

<Property/> nodes
Each <Property/> node specifies a public property. A <Property/> node has the following structure, where property is the name of the public property and value is its value:

```
<Property name="property" value="value" />
```

You can install the software faster by disabling log-file creation: Simply change the value of the ICA.LogOptions property to an empty string.

For a list of available public properties, see page 13.

Creating a server image with a customized fileset

You can use Setup.xml to create a server image with a customized fileset.

To create a server image with a customized fileset

1 Copy the server image to a new location.
2 Add any desired language-module MSI files to the server image.
3 Edit Setup.xml to reflect the additions you've made to the fileset:
   • Add a <Msi/> node for each new setup file.
   • Add a <Dbm/> node for each new language-module MSI file.
   • Add the following <Property/> node for each new language-module MSI file, where $$ is the language:
     ```
     <Property name="Include.$$" value="1" />
     ```
4 Remove any unwanted MSI files from the server image.
   Some MSI files cannot be removed from the setup fileset. For details, see page 37.
5 Edit Setup.xml to reflect the removals you've made from the fileset:
   • Remove the corresponding <Msi/> node for each removed setup file.
   • Remove the corresponding <Dbm/> node for each removed MSI file.
   • Remove the corresponding <Feature/> node and subnode for each removed MSI file.
   • Adjust any corresponding <Property/> nodes by changing their value.
Deploying customized installation settings

To modify the settings used to install the software on the workstations, you can use the Persist.xml file stored at the root of the server image.

Each entry in Persist.xml corresponds to a public property for the software (see page 13). The syntax of each entry is as follows:

```
<Property name="property" value="value" />
```

By modifying the value of an existing entry in Persist.xml — or by adding a new entry — you can customize the installation settings deployed from that server image. This deployment method offers an excellent alternative to creating a different server image or customizing a command line.

**Example 1** The following Persist.xml entry specifies that automatic software updates are enabled:

```
<Property name="ALLOW_PRODUCTUPDATES" value="1" />
```

By changing the value of this entry from "1" to "0" (and saving this change to Persist.xml), you can disable automatic updates for the workstation installations.

**Example 2** The following Persist.xml entry specifies the serial number for the installation:

```
<Property name="SERIALNUMBER" value="SN" />
```

By changing the "SN" value, you can specify a different serial number for the workstation installations.

Deploying the software with msiexec.exe

Alternatively to using Setup.exe, you can deploy the software by using msiexec.exe — a Microsoft Windows Installer file provided by the Windows operating system. In fact, you must use msiexec.exe if you want to interact directly with the MSI files, such as in the following scenarios:

- if you want to use the Setup.msi file, rather than a start-up script, to install the software by using a Group Policy Object
- if you want to use the Setup.msi file to create packages for use with Novell ZENworks Desktop Management

**Command-line syntax** As with Setup.exe, you use msiexec.exe to create command lines that perform a setup-related function. A msiexec.exe command line requires the following items:

- a switch that signals the desired action: creating a server image (/a), or installing (/i), repairing (/f), or removing (/x) the software
• the location and name of the desired MSI file: typically, Setup.msi
  (located on the installation disc or on the server image).
• any desired public properties
• any desired switches, as specified by the CHAINER_CMD="switches"
  public property (multiple switches are separated by a space)

For example, the following msiexec.exe command line uses the file
\server\WPO16\Setup.msi to install the software while displaying
the full user interface:

  msiexec.exe /i "\server\WPO16\Setup.msi"
  ADDLOCAL="ALL" CHAINER_CMD="/qf"

MST files

As previously explained (see page 38), you can use the TRANSFORMS
public property to apply an MST file to the setup. By default, all MST files
are applied to the Setup.msi file. If you want to apply an MST file to a
different MSI file, you must use the following syntax (where MSI is the
filename of the MSI file, not including its extension; and where MST is the
filename of the MST file, including its extension):

  TRANSFORMS_MSI="MST"

If the MST file is not in the same folder as the MSI file, MST must specify
the full path and filename of the MST file.

For example, the following msiexec.exe command line uses the file
\server\WPO16\Setup.msi to install the software silently, applies the
transformation my_wp.mst to WP.msi (in the same folder), and applies
the transformation my_qp.mst to QP.msi (in the same folder):

  msiexec.exe /i "\server\WPO16\Setup.msi"
  ADDLOCAL="ALL" CHAINER_CMD="/qn"
  TRANSFORMS_WP="my_wp.mst"
  TRANSFORMS_QP="my_qp.mst"
## Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.doc files</td>
<td>associating with WordPerfect</td>
</tr>
<tr>
<td>.ppt files</td>
<td>associating with Presentations</td>
</tr>
<tr>
<td>.xls files</td>
<td>associating with Quattro Pro</td>
</tr>
</tbody>
</table>

## L

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>languages, deploying</td>
<td>27</td>
</tr>
</tbody>
</table>

## M

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>macros</td>
<td>deploying</td>
</tr>
<tr>
<td></td>
<td>installing</td>
</tr>
<tr>
<td></td>
<td>migrating</td>
</tr>
<tr>
<td>maintaining software</td>
<td>20</td>
</tr>
<tr>
<td>migrating</td>
<td>macros and templates</td>
</tr>
<tr>
<td></td>
<td>user settings, automatically</td>
</tr>
<tr>
<td></td>
<td>user settings, manually</td>
</tr>
<tr>
<td>modifying software</td>
<td>22</td>
</tr>
<tr>
<td>MSI files</td>
<td>37</td>
</tr>
<tr>
<td>msiexec.exe, deploying with</td>
<td>43</td>
</tr>
<tr>
<td>MST files</td>
<td>38</td>
</tr>
</tbody>
</table>

## N

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>networks</td>
<td>requirements</td>
</tr>
<tr>
<td>setting up</td>
<td>3</td>
</tr>
</tbody>
</table>

## O

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OXML support</td>
<td>8</td>
</tr>
</tbody>
</table>

## P

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paradox</td>
<td>creating server image</td>
</tr>
<tr>
<td></td>
<td>list of available features</td>
</tr>
<tr>
<td>Paradox deployment</td>
<td>29</td>
</tr>
<tr>
<td>patching software</td>
<td>22</td>
</tr>
<tr>
<td>program defaults, deploying</td>
<td>40</td>
</tr>
<tr>
<td>programs, deploying</td>
<td>15</td>
</tr>
<tr>
<td>public properties</td>
<td>13</td>
</tr>
<tr>
<td>pull installations</td>
<td>10</td>
</tr>
<tr>
<td>push installations</td>
<td>11</td>
</tr>
</tbody>
</table>

## Q

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuickCorrect migration</td>
<td>37</td>
</tr>
<tr>
<td>QuickWords migration</td>
<td>37</td>
</tr>
</tbody>
</table>

## R

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Readme file</td>
<td>3</td>
</tr>
<tr>
<td>reboots, handling</td>
<td>15</td>
</tr>
<tr>
<td>registry keys</td>
<td>39</td>
</tr>
<tr>
<td>removing software</td>
<td>24</td>
</tr>
<tr>
<td>repairing software</td>
<td>20</td>
</tr>
</tbody>
</table>

## S

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCCM support</td>
<td>19</td>
</tr>
<tr>
<td>serial number, inputting</td>
<td>16</td>
</tr>
<tr>
<td>server image</td>
<td>creating Paradox</td>
</tr>
<tr>
<td>server images</td>
<td>basic</td>
</tr>
<tr>
<td></td>
<td>customized</td>
</tr>
<tr>
<td></td>
<td>fileset, customizing</td>
</tr>
<tr>
<td></td>
<td>multiple</td>
</tr>
<tr>
<td>servers</td>
<td>setup</td>
</tr>
<tr>
<td></td>
<td>software requirements</td>
</tr>
<tr>
<td></td>
<td>suppress setup check</td>
</tr>
<tr>
<td></td>
<td>switches</td>
</tr>
</tbody>
</table>

## T

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>table rows, splitting</td>
<td>16</td>
</tr>
<tr>
<td>templates</td>
<td>deploying</td>
</tr>
<tr>
<td></td>
<td>installing</td>
</tr>
<tr>
<td></td>
<td>migrating</td>
</tr>
<tr>
<td>troubleshooting software</td>
<td>25</td>
</tr>
</tbody>
</table>

## U

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>uninstalling software</td>
<td>24</td>
</tr>
<tr>
<td>updating software</td>
<td>22</td>
</tr>
</tbody>
</table>
upgrading software ............ 16
user name, inputting ............ 18

V
videos ...................... 4

W
workstations
  setup ..................... 4
  software requirements ..... 3
WPD files, locking IE display . . 18
writing tools ................ 27